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Trademarks

Microsoft is a U.S. registered trademark of Microsoft Corporation.

Windows 7, Windows 8, and Windows 10, Windows 11 are either
registered trademarks or trademarks of Microsoft Corporation in the
United States and/or other countries.

Other brands and product names herein are trademarks or
registered trademarks of their respective holders.

Copyright

All rights reserved. No part of this publication may be
reproduced, transmitted, transcribed, stored in a retrieval
system, or translated into any language or computer language, in
any form or by any means, electronic, mechanical, magnetic,
optical, chemical, manual, or otherwise, without the prior written
permission of Avision Inc.

Material scanned by this product may be protected by
governmental laws and other regulations, such as copyright
laws, the customer is solely responsible for complying with all
such laws and regulations.

Warranty

The information contained in this document is subject to
change without notice.

Avision makes no warranty of any kind with regard to this
material, including, but not limited to, the implied warranties
of fitness for a particular purpose.

Avision shall not be liable for errors contained herein or for
incidental or consequential damages in connection with the
furnishing, performance, or use of this material.
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Federal Communications Commission (FCC) compliance
information statement
Part 15

The product has been tested and found to comply with the limits
for a Class A digital device pursuant to Part 15 of the FCC Rules.
Operation is subject to the following two conditions: (1) this
device may not cause harmful interference and (2) this device
must accept any interference received including interference that
may cause undesired operation.

The FCC Class A limits are designed to provide reasonable
protection against harmful interference when the equipment is
operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy and, if
not installed and used in accordance with the instruction manual
may cause harmful interference in which case the user will be
required to correct the interference at his own expense.
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European Union Regulatory Notice

Products bearing the CE marking comply with the following EU
Directives:

® Low Voltage Directive 2014/35/EC

® EMC Directive 2014/30/EC

® Restriction of the use of certain hazardous substances (RoHS)
Directive 2011/65/EU

CE compliance of this product is valid if powered with the correct
CE-marked AC adapter provide by Avision.

This product satisfies the Class A limits of EN55032, EN55035,
and safety requirements of EN62368-1.

CE Warning

This is a class A product. In a domestic environment this product
may cause radio interference in which case the user may be
required to take adequate measures.

*This machine is certified as Class 1 LED product.
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Disposal of Waste Equipment by Users in Private Union
|

This symbol on the product or on its packaging indicates that the
product can not be disposed of with your other household waste.
Instead it should be sent to appropriate facilities for recovery
and recycling in an effort to protect human health and the
environment. Fore more information about where you can drop
off your waste equipment for recycling, please contact your local
city office, your household waste disposal service or the shop
where you purchased the product.

System Requirements

CPU: Intel® Core™ 2 Duo or higher

Memory: 32 bit: 2 GB
64 bit: 4 GB

Optical Drive: DVD-ROM Drive
USB Port: USB 3.2 Gen 1x1 (compatible with USB 2.0/1.1)

Compatible Microsoft Windows 11, Windows 10 (32 bits/64
Operating bits), Windows 8 (32 bits/64 bits), Windows 7
System:
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Product Safety Guide

Please clearly read all these instructions, and follow all instructions
and warnings before installing and using the device.

The following indications are used in this document to obviate any
chance of accident or damage to you and/or the device.

WARNING Indicates potentially hazardous situations, which

if instructions are not followed, could result in
death or serious injury.

CAUTION Indicates a potentially hazardous situation

which, if instructions are not followed, may
result in minor or moderate injury or damage to
property.

WARNING

Use only the power cable and the USB cable that came with
your device and avoid abrasions, cuts, fraying, crimping,
and kinking. Using any other power cable and USB cable
could cause fire, electrical shock, or injury.

Place the device close enough to the computer so that the
interface cable can easily reach between the device and the
computer.

Do not place or store the device:

e Outdoors

e Near excessive dirt or dust, water, or heat sources

e In locations subject to shocks, vibrations, high
temperature or humidity, direct sunlight, strong light
sources, or rapid changes in temperature or humidity

Do not use the device with wet hands.

Never disassemble, modify, or attempt to repair the device
or device option by yourself, except as specifically explained
in the device's documentation. This could cause fire,
electrical shock, or injury.

Vi



User’s Manual

Unplug the power cable and the USB cable, and refer
servicing to qualified service personnel under the following
conditions:

Liquid has entered the device.
Object has entered the device.

The device has been dropped, or the case has been
damaged.

e The device does not operate normally (i.e. appearance
of smoke, strange smell, odd noise, etc.), or exhibits a
distinct change in performance.

Unplug the power cable and the USB cable before cleaning.

CAUTION:

Do not locate the device on rackety or aslope tables. Do not
locate the device on unstable surface. The device may fall
down and this may result in injury.

Do not place heavy objects on the unit. It may cause
unbalance and the device may fall down. This may result in
injury.

Store the power cord/USB cable bundled out of the reach of
children to avoid the risk of injury.

Keep plastic bags bundled out of the reach of children to
avoid the danger of suffocation.

If you are not going to use the device for a long period,
unplug the power cable from the electrical outlet.

Vii



User’s Manual

1. Introduction

Congratulations on your purchase of the high speed document
image scanner. With this scanner, you can you scan your
stack of documents up to 500 pages at one time to boost your
productivity.

Before you install and operate the new scanner, please take a
few minutes to read through this manual. It provides proper
instructions for you to unpack, install, operate and maintain
the scanner.

1.1 Package Items

The following figure indicates the package contents. Please
check all the items against your checklist. If you do not
receive all the items, please contact your authorized local
dealer immediately.

1-1
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Scanner Main Unit

Quick Guide

USB Cable

Power adapter & power cord
Ethernet Cable (Optional)
Print Cartridge

1.
2.
3.
4.
5.
6.

Note:

1. Only use the power adapter FSP/FSP090-AABN3 included in
the machine. Using other AC adapters may damage the
machine and void the warranty.

2. Please unpack the packing carefully, and check the contents
against the checklist. If any items are missing or damaged,
please contact your dealer immediately.

3. To access more service supports, visit www.avision.com to
register your Avision’s product.
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1.2 Front View

Paper Guide

Paper Guide

ADF
Paper Tray

Paper Stopper

LCD Screen with
Up/Down Buttons

_______

~ Cancel Button

~ Scan Button

Power Button

Paper Guide
Part Name Function
Extension Can be pulled out and adjusted to the

size of the document being scanned.

ADF Paper Tray

Load the document onto this part
when scanning document.

Paper Guides

Adjusts to the width of the documents
to prevent skewing of the scanned
pages.

Operation Panel

LCD screen:

Shows a number indicating a scan-to
destination via the Up/Down buttons.
The Power Button:

Press to turn on the power.

The Scan Button:

Press to start a scan.

The Cancel Button:

Press to cancel a scanning job during
operation.

Paper Stopper

Adjust to the length of the documents
to prevent them from falling apart.

1-3
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1.3 Control Panel

Item

Description

= Display the scanning and error status.

>

Display using Button Manager V2 and its
function.

Used to select an item.

>

Press to start a scan via the software
application - Button Manager V2.

Press to confirm a selection.

Press to cancel a scanning job during
operation.

Press to return to the previous screen.

Press to turn on the power.
Long press to turn off the power.

1-4
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1.4 Rear View

i S ——
1 .'q
|HL_ __Er- — ‘TL |
A ‘ | T
LAN Port ;Z% — ;|:r_‘l :
USB Port Power Jack
Part Name Function
LAN Port Connect to the network.
USB Port Connect to your computer.
Power Jack Connect the power cord to a
power outlet.

1-5
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1.5 Removable Parts

g

ADF Roller

.-I. . ‘
LA iy

Y
Reverse Roller

1-6
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1.6 LCD Display

USB Connection
After installing the scanner driver and connecting the scanner to

your computer via the USB cable, the following LCD display will
be prompted:

successful USB
connection E' {}

You may use a TWAIN-compliant application such as Avision
Capture Tool to start a scan. Refer to chapter 4 —_Using Avision
Properties Dialog Box for more details on how to start a scan.

LAN Connection

1.

After installing the scanner driver, Button Manager,
connecting the scanner with an ethernet cable, and opening
the Button Manager, the following LCD display will be
prompted:

successful LAN
0 {} connection
L LSH
2Pl — Indicates the login
name of your
computer

1-7
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2. Press .ov.l (OK), the following Button Manager panel will
be displayed. Use the Arrow key to select your desired
button no. or destination. Up to 9 destinations can be

selected.
1 EJ tscan(image) g |ié] Printer
2 il iscantocR) 6 £3 sharedFolder

Indicates —— =

Button # and 3 -'E| Scan To App T @FI'P

Button Name
il [E"EL E-Malil 8 a: Share Point
5 [Jé Printer 9 ° Google Drive

3. Press N (Scan button), the paper starts feeding into the
scanner and the scanned image will be sent to your
specified destination.

Refer to chapter 6 - Using the Buttons on how to press the
button to complete a scan.

NOTE:
e Please note the USB mode and LAN mode can not be
® used at the same time.

e The following error will be prompted if Button Manager
has not been opened.

Error!

Please open
Button
Manager V2!

1-8
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Status Bar/Options

Icon/Option | Status Indication

Successful USB connection between PC and
E' scanner

Successful ethernet cable connection.

'ﬁ' Select to access more settings.
WPS

Select to use WPS (Wi-Fi Protected Setup) to
connect to a wireless access point which
supports WPS.

Turn off the sleep mode so the device is
always turned on without the need to wake it
up. Choice: On, Off

Note: When the [sleep mode] is turned off,
the [Energy Saver] will be disabled. Yet, the
[Auto Power Off] will not be disabled.

Sleep Mode

Select to view the scanner’s information

Information including scanner, ethernet and Wi-Fi.

Select to return to factory default settings
including DHCP enable, turning off Wi-Fi,
default device name, host name, and SSID.

Factory
Default

1-9
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2. Scanner Installation

2.1 Precautions

m  Keep the scanner out of direct sunlight. Direct exposure
to the sun or excessive heat may cause damage to the
unit.

= Do not install the scanner in a humid or dusty place.

= Place the scanner securely on an even, flat surface.
Tilted or uneven surfaces may cause mechanical or
paper-feeding problems.

= Retain the scanner box and packing materials for
shipping purposes.

2-1
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2.2 Connecting to Power

Before connecting, make sure the power switch is off.

Plug the small end of the power adaptor into the power jack of
your scanner. Insert the other end to an appropriate power
outlet.

2-2
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2.3 Turning on the Power

Press the Power Switch button on the front panel, the Power
LED will flash. When it is finished and ready to scan, the LED
indicator will stop flashing and become steadily on. To turn
off the scanner, press the Power Switch button for about 3
seconds, the Power LED will be off.

2-3
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2.4 Connecting to Computer

1.

Connect the square end of the USB cable to the USB port of
your scanner. Connect the rectangle end to the USB port at
the rear side of your computer.

Note: The scanner is designed with a USB 3.2 Gen 1x1
interface to ensure the optimal speed. If your computer
comes with a USB 3.2 Gen 1x1 port, make sure to connect
the scanner to your computer to the USB 3.2 Gen 1x1 port
which is distinguished in blue color at the back of your
computer. The USB 3.2 Gen 1x1 port enhances your
scanning speed and is also compatible with USB 2.0 and
usB 1.1.

The computer should detect a new USB device and prompt a
“New Hardware Found” message.

By following the on-screen instructions, click the Next
button to continue. When the certification screen appears,
click Continue Anyway to complete the installation.

When the Finish dialog is prompted, click the Finish button.

2-4
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2.5 Connecting a Network Cable

1. Connect one end of your network cable to an available port
of the switching hub of your LAN.

2. Connect the other end to the LAN port marked F'%’ at the
back of the product as shown.

2-5



User’s Manual

2.6 Installing the Scanner Driver

NOTE:

! The scanner driver contains TWAIN, ISIS and WIA driver.
After the installation of scanner driver is completed, this
scanner allows you to scan via a TWAIN, ISIS, or a WIA
interface.  Start your TWAIN-compliant image editing
software application to select a TWAIN or WIA user
interface or your ISIS software to select an ISIS user
interface. You may also launch Microsoft’s Scanner and
Camera Wizard to scan via a WIA user interface.

1. Download [Avision Update] at
http://www.avision.com/install.

2. Run [Avision Update.exe].

3. The End User License Agreement screen will be prompted.
Read the agreement and then choose [I Agree].

2-6
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4. Click [Next] to continue.

5. The available software applications will be prompted. Select
the applications to install. Click [Install] and follow the on-
screen instructions to complete the installation.

A\.fis_fnn AXKX

*The list of available software applications varies according
to your product type.

2-7
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Contents on the installation graphic:

e Driver: To communicate with your scanner, you need
to install the scanner driver.

e Virtual Scanner Link: To connect your computer to the
scanner in the network, you need to install the Network
Setup Tool.

« Button Manager V2: To use the buttons on the
scanner, you need to install Button Manager V2.

e AVScan X/PaperPort: To scan and organize your
multi-page document(s), you can install the software
application to manage them easily and effectively.

Alternatively,

You may also download driver and manual at
www.avision.com/download.

2-8
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2.7 Connecting to the Network Scanner

Before connecting to the network scanner, make sure that
Virtual Scanner Link (Network Setup Tool) has been installed
onto your computer. The Network Setup Tool is included in the
supplied software CD.

1. Start [Virtual Scanner Link] by choosing Start>All
Programs>Avision Virtual Scanner>Virtual Scanner
Link. The main window will be displayed and the scanners
in your network will be searched automatically. In a few
seconds, the result including the scanner model and
scanner’s IP address will be displayed as shown.

2. Choose the scanner you wish to connect and then press
[Connect]. If connection is successful, a connection mark
will be displayed as shown.
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After the scanner has been connected successfully,
launch your TWAIN-compliant image-editing software
application to start a scan (Figure A).

Or simply press the [Scan] button on the scanner to
start a scan (Figure B).

SCAIET PC

| - |

Figure B

2-10
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Note:

e The VSL program allows multiple users to connect to the
network scanner at anytime. Yet, the scanner operation can
be used by one user at a time. If the network scanner is
being used by other user, you will be prompted with a
message to connect the scanner later. When the scanner is
available, you will also be prompted with a message to
connect the scanner and start scanning your document.

e If the network scanner has not been found, it is probably the
scanner and your computer are not in the same LAN. In this
case, you can assign a specific IP address of the scanner to
let [Virtual Scanner Link] automatically search the scanner.
Click the [Option] button, type your IP address on the
[Searching Address] field (1), then click the [+] button (2)
and finally click [OK] (3) to complete.

1) S

(3) L

| - — —

e Searching Time: When the program is launched, it
automatically searches the scanner in the network in 5
seconds (default). The searching time can be changed from
a range of 5 to 20 seconds.

e If the [Virtual Scanner Link] program has been closed and
then launched again, [Virtual Scanner Link] will
automatically search and connect the network scanner it has
previously connected to.

2-11
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The connection is always enabled, whether the scanner
enters into the sleeping mode or turns off and on again.
VSL will automatically detect the previously connected
scanner and connect again.

[Automatically searching and connecting device]:
Check this option and enter your time (1~5 min.) to
allow the VSL to reconnect to the device every specified
minute(s) if the device has been woken up during sleep
mode or the device has been turned off and on again.

[Connecting the device with a specified name
instead of a login name]: Check this option and enter
your desired name for the computer. Yet you need to
reconnect the device again to refresh the status.

2-12
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2.8 How to Switch to Another Computer on the Network
Scanner

Please follow these steps to connect the network scanner to
other computer in the network:

Turn on the scanner.

2. Make sure that a LAN (Ethernet) cable has been connected
to the scanner and that the Virtual Scanner Link (VSL) has
been installed to your computer. (Refer to the preceding
section 2.3~2.7)

3. On your computer, start [Virtual Scanner Link] by
choosing Start>All Programs>Avision Virtual
Scanner>Virtual Scanner Link. The main window will be
displayed and the scanners in your network will be searched
automatically.

4. In VSL main window, connect the scanner.

Open Button Manager 2 by choosing Start>All
Programs>Avision Button Manager.

6. A list of computers (login names) connecting to the scanner
will be displayed.

1.PC1
2.PC2
3.PC3
4.PC 4

7. Use the Arrow key to select the computer you want to
connect and then press the [Scan] button. The Button Panel
will be displayed.

2-13
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1 El..i iScan(Image)
2 ﬂ]l iScan[OCR)
3 <] scanTospp
4 D4l emai
5 =) Printer

Use the Arrow key to select your desired Button No. or
destination and then press the [Scan] button.

The scanner starts feeding your paper and the scanned
image will be sent to your specified application or
destination.

-
HE R ]
LEM |
I | | | |
u i Ly ?.-!-. W
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2.9 How to Block Other Users from Using the Network

Scanner

Please follow these steps to temporarily prevent other users from
using the network scanner:

1.

Make sure that a LAN (Ethernet) cable has been connected
to the scanner and that the Virtual Scanner Link (VSL) has
been installed to your computer. (Refer to the preceding
section 2.3~2.7)

On your computer, start [Virtual Scanner Link] by
choosing Start>All Programs>Avision Virtual
Scanner>Virtual Scanner Link. The main window will be
displayed and the scanners in your network will be searched
automatically.

In VSL main window, connect the scanner.

Open Avision Capture Tool by choosing Start>All
Programs>Avision XXX Scanner>Capture Tool. Select
the scanner model and then the main window will be
displayed.

j-_..," L g e Bl Hsa p = g icacm -'-:I -

Click the Scan button ( v ) or choose Scan from the File
menu. The following screen will be displayed on the scanner
panel. This screen indicates the scanner is temporarily
locked by a specific user.

PC 1

Eoadhy to Scan
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6. Press the [Scan] button, the paper starts feeding into the
scanner and the scanned image will be displayed.

Note:

e The timeout for the lock status is 60 seconds.

° If you wish to cancel the lock status within timeout, press X
(the Cancel button) on the scanner.

2-16
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2.10 How to View Scanner’s Detailed Information

1. On the scanner, press the [Scan] button to select [More

Settings] ﬂ and then press the [Scan] button to confirm. The
screen including and [Information] option will be displayed.

2. Select [Information], and press the [Scan] button, and then
choose your desired option. The information about the option
will be displayed as indicated.

Scanner Information:

Tray Adjust Scanner Model Name:
Information Ethernet ADXXXXN
Clean Mode —» | Counters — FW Version:
XXXXXXX
Factory Default S/N:
AXOOOXXXXXX
Ethernet Information:
Trav Adiust Scanner IP Address
ray Acjus 10.1.23.45
Information Ethernet MAC Address:
Clean Mode —> [Counters |__, | 000232-
Factory Default 1a2b3c
DHCP:
Enable

Counter Information :
Counter : The scan count of ADF roller and Reverse roller

Tray Adjust Scanner Total:
10
) Ethernet
Information c . ADF roller:
Clean Mode > ounters —» 5
Factory Default Reverse roller:
5

2-17
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2.11 How to Change the Scanner’s IP Address and Device
Name

1. Start [Virtual Scanner Link] by choosing Start>All
Programs>Avision Virtual Scanner>Virtual Scanner
Link. The main window will be displayed and the scanners
in your network will be searched automatically.

Lo 1] AR EE — Y

2. Click the scanner’s IP address as indicated. The scanner’s
web page will be displayed.

3. Please login first with the default user name and password -
[admin]. Click [Network] and then [Wired]>[Next] to enter
your specific IP address or change the device’s host name.
Finally click [Next]>[Export] to complete.

2-18



User’s Manual

il rma e fsrm] =etnes
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Note:

You may also use the webpage to change your connection
type, authentication method, or connect to other access
point or router which supports the WPS connection.
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2.12 Accessing the Scanner’'s Web Page

To access the scanner’s web page, please follow these steps:

Starting your browser.

2. Type the IP address of the scanner on the URL address,
the embedded web page will be displayed.

3. Login first with the default user name and password -
[admin].

4. Change your settings and then click [Update] to
complete.

To overview the menu items:

Information

Displays the scanner’s basic information including scan count
via ADF or consumables. Click [Reset Counter] after a new

replacement has been installed.

Account Management

Used to change your login name and password. (Up to 32

characters long.)

Network

Choose your network connection. Choice: *Wired, Wireless
(Client Mode), Wireless (AP Mode), Wired+Wireless (AP Mode),
Off All Network
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Network Port Setup

Web Server

Choice: *http/https

Choose https if you wish to encrypt your web
server. A preset certificate will be provided by
default.

Certificate Management

Certificate Upload

Client Enter the required password. When uploading

Password Client Certificate, you need to enter the correct
certificate password.

Client Choose the file of your device certificate.

Certificate

Certificate Display current certificates you have submitted.

List

Action: Delete (delete your certificate)

* Default settings to be shown in italic bold style
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2.13 Installing the Printer Cartridge

1. Open the box of the print cartridge and remove the
protective tape from the bottom of the cartridge.

0y

l IMPORTANT:

# o If youremove a print cartridge, replace it
immediately. If the cartridge is outside of the device
for too long, the ink can dry and clog the nozzles.

e Carefully hold the ink cartridge to avoid staining your
clothes or the surrounding area.

2. Hold the tab and do not touch the ink nozzles (@) or the
gold contacts (@) after the tape has been removed.

2-22
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-

4. Open the Print Cartridge Holder by lifting up the locking
lever with your finger.

e
- = L

- L2 -

* b+ & b

3. Open the Imprinter Cover.

5. Grasp the tab of the cartridge and insert the cartridge into
the holder with the label facing up and the tab pointing to
the left.

2-23
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6. Lower the locking lever of the Print Cartridge Holder until it
locks in.

7. Position the print cartridge holder along where the document
will pass through.

2-24
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8. Align the arrow mark on the print cartridge holder with the
arrow mark on the product as illustrated.

IMPORTANT:

If the arrow marks have not been aligned, the imprinter

is not in a position to print any characters on your
document.

;U——'—‘i--'l'"r'-u. T
L A 2
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9. Close the Imprinter Cover.

' IMPORTANT:

# 1. In the upper back of the Print Cartridge Holder are
the document size markings; use them to adjust for
paper size or document print starting position.

2. Place the actual document in the ADF and confirm
that the print cartridge is positioned within the
document width.

Document
Width

eyl
f

3. Once a print cartridge has been installed, do not
remove it from the machine and leave it out in the
open. This will cause the print cartridge to dry out,
and the device may not operate properly when it is
reinstalled. To maintain optimal printing quality, use
a print cartridge within six months of first use.

2-26



User’s Manual

3. Completing Your First
Scan

3.1 Loading Your Document in the ADF Paper Tray

3.1.1 Notice on Using the ADF

Before using the ADF, please make sure that your paper meets
the following specifications:

o Document (s) can range in size from 50 x 85 mm (2 x 3.3
in.) to 308 x 432 mm (12.12 x 17 in).

o Document (s) can range in weight from 27 ~ 413 g/m? (7
~ 110 Ib.) (Straight paper path)

o Document (s) can range in weight from 27 ~ 105 g/m? (7
~ 28 Ib.) (U-Turn paper path)

o ID cards up to 1.25 mm (0.05 in.) thick
. Plastic cards compliant with the ISO7810 ID-1 type

o Document(s) should be square or rectangular and in good
condition (not fragile or worn).

. Document(s) should be free of curl, wrinkle, tears, wet ink,
or punch holes.

o Document(s) should be free of staples, paper clips, paper
sticky notes.

3-1
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Fanning Your Document

Note:

To avoid occasional multi-feeds or paper jams, please fan your
documents and align the top edges before feeding them into
the scanner.

1. Hold both ends of the documents and fan them a few
times.

2. Rotate the documents by 90 degrees and fan them in the
same manner.

3. Align the edges of the documents by tapping the bottom
of the stack against the table top. Rotate the stack 90
degrees and repeat.
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Document Feeding

1. Unfold the document feeder and its extension.

2. Unfold the output tray and raise the paper stopper.
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3. Adjust the paper guide to hold your multi-page document.

4. Load the stack of document facing up with the top of the
pages pointing into the feeder.

5. Verify that the paper guides are aligned with the edges of
the stack.
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6. To scan A3-sized paper, pull out the extension of the
Input Tray and Output Tray as shown. Load the stack of
document facing up with the top of the pages pointing
into the feeder. (Input tray total weight under 7kgs))
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Alternatively,

Move the switch in the center down then the right paper guide
can be moved separately with the left paper guide and vice
versus. And then load your document between two paper guides
as indicated.

: — ==
I; — : E .
E I =E
— |F L= T | —

Select the Paper Path

Scanned documents can be exited to the output tray in the
front of the scanner or to the straight path tray in the back of
the scanner. The paper path is automatically switched when
the straight path is opened or closed.

"'”f".'l : B

T, ] . -";'__'.-

i
B!
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3.1.2 Scanning a Stack of Document with Various sizes
and Weights

When scanning a batch of documents with different sizes and
weights, be sure to follow these guidelines to avoid a skewed
image or a paper jam:

1. Align the documents TOP EDGE first in the sequence of
paper size from large to small.

2. If two pages are of the same size yet with different weight,
arrange these pages in the sequence of paper weight from
heavyweight to lightweight.

il
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3. Align the edges of the documents by tapping the bottom of

the stack against the table top.

[l

1

e

L

|
L

L

e
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4. Center these pages in the document feeder and make sure
that the edges of page of the largest size slightly touch the

Paper Guide.
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3.2 Specifying Number of Sheets Loaded in the Input Tray

You may specify number of sheets loaded in the Input Tray to
reduce the time to lift up the Input Tray.

To specify number of sheet via the Control Panel,
1. On the scanner, press V (Down arrow) to select [More

Settings] .ﬁ. and then press the [Scan] button to confirm.

0 .a Tray Adjust
Information
UsB

Clean Mode
>

Factory Default

2. Make sure [Tray Adjust] is selected. The following options
will be displayed.
|| 50

|l 125
|l 250
|| 375
|| s00
3. Use A or V¥ to select your desired number. Choice: 50, 125,
250, 375, 500 sheets (default).

4. Press the [Scan] button to confirm your selection and return
to the main operational screen.

Or
You may specify number of sheet via the Scan Properties dialog
box from TWAIN user interface. (See Paper Tab in chapter 4)
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3.3 Verifying Your Scanner Installation

To verify if your scanner installation is correct, Avision provides
you a useful test program called Avision Capture Tool. With this
tool, you can perform simple scans and view the captured
images. In addition, it helps you complete your scan at a rated
speed.

The following procedure describes how to verify your scanner
installation. If the installation is not correct, please review the
preceding section to check if the cable connection and scanner
driver have been successfully installed.

Before you begin, be sure the scanner is on.

1. Select Start>Programs>Avision xxx Scanner>Avision
Capture Tool. The Select Scanner Model dialog box will be
displayed.

2. Select your driver type and scanner model and click OK. The
following Avision Capture Tool dialog box will be displayed.
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Save File Format File Path

Setup Scan

3. Choose your desired file format from the File Format drop
down list box. (Default is JPEG, other choice includes TIFF,
MTIFF, PDF, MPDF, GIF, and BMP.) The supported file
formats vary depending on your scanner model.

4. Type your desired folder name and file name in the File Path
box. (Default is C:\Documents and Settings\User Name\My
Documents\My Scan\Image.)

Note: If you do not wish to save the scanned image, deselect
the Save button since default is Save Enable. In this case,
the thumbnail view will be disabled. And therefore, after
viewing all the scanned images, only the last one will remain
on the screen.

&

5. Click the Setup button ( ':F "m) or choose Setup from the
File menu to prompt the Scanner Properties dialog box.
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Image —
Selection
Box

6. From the Image Selection Box, choose your desired image
type for your scanned image. (Default is Front B&W) If you
have a duplex scanner, choose Front and Rear to scan both
sides of your document.

7. Click OK to quit the Scanner Properties dialog box. (To learn
more details about the Scanner Properties dialog box, please
see the subsequent chapter, Using the Scanner Properties
Dialog Box.)

8. Place your document face down on the document glass or
face up in the auto document feeder.

9. In the Scan Validation dialog box, click the Scan button

( ¥ 7 ) or choose Scan from the File menu.

10. The document will be scanned and displayed in the Scan
Validation screen. After the scanned images have been
displayed, your scanner installation verification is completed.
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Display View

Thumbnail View

11. You can view the scanned image in Fit Page (-ﬁ) or Actual
Size (100%) button (D ) from the Viewing toolbars at the
right side.

12. Click the Close box or Quit from the File menu to exit the
Scan Validation Tool.
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3.4 A Glance of the Scanner Properties Dialog Box

g (=

1 e —
27 o = 3
——24
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. Tab Options

Choice: Image, Compression, Color Dropout,
Paper, Multi-Feed Detection, Preview, Options,
Settings, Information.

2. Image Choose your image type and the side of
Selection Box |[document you wish to scan. Options vary
based on type of scanner.
3. Brightness Adjust the brightness level from -100 to +100.

4. Contrast Adjust the contrast level from -100 to +100.

5. Resolution Determine the quality of the scanned image.
The industry standard is 200 dpi.

6. Invert Reverse the color of your scanned image.

7. Scan Source |[Choice: Auto Document Feeder, Flatbed,

Flatbed (Book), Automatic (varies due to
different scanner model)

. Defaults

Reset all values on the tabs to the factory

default settings.
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3.5 Printing Your Information

The Imprinter tab in the scanner’'s TWAIN user interface
(Scanner Properties dialog box) allows you to print alphanumeric
characters, date, time, document count and custom message on
the front side of your document.

To print your information,

1. Click the [Imprinter] tab to prompt the Imprinter dialog
box.

aaaaaa

2. Check [External Imprinter].

Set your preferable settings for your print text. (Refer to the
subsequent section 4.13 The Imprinter Tab for more
detailed information.)

2. Click the [Scan] button to start scanning and printing your
information.
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Note:
The arrow marks indicate the printable positions.
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4. Using the Scanner
Properties Dialog Box

The Scanner Properties dialog box allows you to configure the
scanner’s settings. It consists of several tabbed windows each
of which will be described in this chapter.

Note: In this chapter, all options are available based on a
duplex (double-side) scanner. If you have purchased a simplex
(single-side) scanner, all options are available for single sided
only.
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The Scanner Properties dialog box
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4.1 Buttons on the Scanner Properties Dialog Box

Frd Sk e | i — —— e

e i e

The buttons on the Scanner Properties dialog box

Buttons | Description

Defaults | Click the Defaults button, the factory default
settings will be shown on each tab.

Cancel Click the Cancel button to leave the Scanner
Properties dialog box.
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The following table shows the default settings :

Tab name

Default settings

Image

Image : Front B&W

Binarization : Dynamic Threshold
Resolution : 200 dpi

Invert : Blank on White

Scan Source : Auto Document Feeder
Threshold : None

Brightness : None

Contrast : None

Compression

None

Color Dropout

None

Paper

Cropping : Automatic
Deskew : Yes
Orientation : Portrait
OverScan : 0.00

Note: The availability of this option
varies due to scanner model.

Unit : Inch
Multi-Feed None
Detection
Preview None
Options Rotation Degrees : None
Blank Page Removal : None
Edge Fill : White > 0 mm
Image Control Option : None
Setting Enable Energy Saver : Enable, 15
minutes after last scan action
Show Scanning Progress : Yes
Show Warning Message : Yes
Save Settings after Closing : Yes
Imprinter Digital Imprinter
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4.2

Showing or Hiding Tabs

The [Scanner Properties] dialog box is displayed in default
with three basic tabs - Image, Paper, and Information. To
show more tabs, click the [Scanner Properties] icon to access
more scan settings.

To show more tabs,

1.

Click the [Scanner Properties] icon (E) on the upper
left corner, and choose [Tab] to show available tab names.
The available tabs include Compression, Color Drop out,
Preview, Rotation, Separation, Multi-Feed, Options,
Settings, and Imprinter. (Note: the options vary based on
scanner model.)

Choose the tab you want to display. The selected tab will
be shown with a check mark and then displayed in the
[Scanner Properties] dialog box.

To access the settings, click the selected tab on the top of
the [Scanner Properties] dialog box. The page of the
selected tab will be displayed.

To hide a tab window,

1.

Click the [Scanner Properties] icon (E) on the upper
left corner, and choose [Tabs] to show available tab
names.

Choose the tab you want to hide. Then, the selected tab
will be hided in the [Scanner Properties] dialog box.

Note: The [Image], [Paper], and [Information] tab can
not be hided since they preprogrammed to be displayed by
default.
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4.3 The Image Tab

The Image tab allows you to choose the front side and (or) the
rear side of your document, the type of image, and to set
several basic scan settings. Note that except for the resolution,
you can set individual scan settings for the front side and the
rear side. For example, all settings in the Image tab,
Compression tab, Color Dropout tab can be set individually for
the front and the rear side. However, the settings in the Paper
tab, the Option tab, and the Setting tab have to be set the
same for the front and rear side.
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The Image tab dialog box
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4.3.1 The Image Selection Box

The Image Selection box includes the
Lol image type and document side option. If
you wish to scan both the front side and
the rear side of your color document, you
can check both Front Color and Rear Color
at the same time. Note the options vary
based on type of scanner.

Example 1 : Scanning a two-sided color document, both
sides in color

P i ki b e i

e e

s XU

Fmm dain | i Db [ ———m—rn i

..... ..-. e — - e

-'-ll. -

- . i
Side/Image Front Rear
Selection
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Example 2 : Scanning a two-sided color document, one in
B&W, the other in color

[F v i

L A ]

=)

Side/Image Front

Selection ron Rear

Image Type | Description

Color Choose Color if you wish to scan a color
image for your original in color.

Gray Choose Gray image if your original contains
actual shades of gray.

B&W Choose B&W if your original contains only

text, pencil or ink sketch.

Color
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Front/Rear Auto Color Detection:

Click to automatically detect and scan the front or the rear page
of your color document in color image mode. If your document
is in colors, the scanner will automatically scan the document
into a color image. If your document is non-color, you can
choose the output to be either B&W or Gray from the Non-Color
Selection option. This option is useful when you have a mixture
of color and non-color document.

Note: If you choose Front Rear Auto Color Detection, you can
not specify the image mode of your rear page and vice versas.

Modes of Auto Color Detection:

If [Front/Rear Auto Color Detection] is selected, its modes
will be displayed. Choice includes Normal, Ignore Paper
Color. For paper with background color such as invoices,
choosing [Ignore Paper Color] will automatically remove the
background color and enhance the detection accuracy.

ELISTRCE [TTRErT I
FRIE T o e o o e e o ST R S

e e W) e e
- R {5 i -
g o
Normal Ignore single background
color
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Sensitivity of Auto Color Detection

If your documents contain primarily B&W text and small
amount of light or pale colors and you do not wish them to be
recognized as color image to save the file size, you can increase
the sensitivity value by moving the bar to the right to let these
images to be detected as B&W. The value ranges from 1 to 100.
The default is 37.

|:—- FITATEY e T
—er L.
I N e e

1 A

T TR

— Mae A

— \-

- e M (T TR R T
i e noa
LI mlber

Original
B e .....-.-h...,. - F e T
o e e T e e e
- HF RS erey :-r: - [ RLRSYFETY
- 't in ri.:\.'. r| . - - " ':-.-.HI .'Ii.:.'.l "'""' -‘...."-..
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& = | &
Sensitivity: 1 Sensitivity: 100
(The image is recognized | (The image is recognized
as a color one) as a black and white one)
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Same settings on both sides:

Click to apply same scan settings for both sides of your
documents. After checking this option, any settings you have
changed will automatically applied to both the front side and
the rear side. For example, if you choose your ideal resolution
to be 300 dpi, this will be applied both to the front side and
rear side of your document.
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4.3.2 Other Image Options

Binarization

This is the process of converting a
grayscale or color image to a bi-tonal
image. There are several different
methods of performing this conversion.
Options: Dynamic Threshold,
Dynamic Threshold (AD), Fixed
Processing, Halftone 1~5, Error
Diffusion.

Dynamic Threshold: Selecting
Dynamic Threshold allows the scanner
to dynamically evaluate each document
to determine the optimal threshold value
to produce the highest quality image.
This is used to scan mixed document
containing faint text, shaded background,
or color background with a single setting.
If Dynamic Threshold is selected,
Threshold, Brightness, and Contrast are
not available.

Dynamic Threshold (AD): Selecting
Dynamic Threshold (AD) to perform
the enhanced mode of the Dynamic
Threshold feature. However, using this
mode may slow down your scanning
speed.

Sensitivity of Dynamic Threshold
Occasionally your scanned image may
contain small dots or speckles. To remove
these spots, increase the sensitivity value
by moving the bar to the right. The value
ranges from 1 to 30. The default is 20.
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Fixed Processing: Used for black-and-
white and other high contrast documents. A
single level is set to determine the black-
and-white transition. The threshold is
programmable over the entire density
range. Fixed Processing sets Contrast to
0. If Fixed Processing is selected,
Contrast is not available.

Halftone: In addition to the black and
white display, Halftone can present a
somehow gray shade of image by using
different size of dots. Halftone image looks
like the picture we have seen in the
newspaper. Options include Halftone 1,
Halftone 2, Halftone 3, Halftone 4,
Halftone 5.

Error Diffusion: Error Diffusion is a type of
Halftone. Error Diffusion gives good image
texture and makes text in images more
readable than Halftone.

Halftone Image o
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Error Diffusion Image
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Dynamic Threshold

Dynamic Threshold (AD)
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Threshold

Used to convert a grayscale image to a
bi-tonal image. The value ranges from 0 to
255. A low threshold value produces a lighter
image, and can be used to subdue
backgrounds and subtle, unneeded
information. A high threshold value produces
a darker image, and can be used to help pick
up faint images.

Adjust the threshold setting by dragging the
Threshold sliding bar to the left or right to
achieve the desired threshold setting.

2 M 23

200 dpi, 200 dpi,
Threshold:50, Th_reshold:100,
Brightness: 0 Brightness: 0
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Gray

Document Type: Choice: Normal, Photo, Document
Three options of document type are provided when you choose
Gray as the image type for your scanned document. Choice:
Normal, Photo, Document.

o Document: Choose Document if your original contains
pure text or a mixture of text and graphic since it is an
optimal setting for regular business document. When
using Document, only Threshold can be adjusted.

o Photo: Choose Photo if your original contains photo to
reproduce your photo in vivid grayscale image. When
using Photo, no Threshold and Contrast can be adjusted.

. Normal: When using Normal, Threshold, Brightness, and
Contrast can be adjusted.

Threshold: The value ranges from 0 to 255. The default is
230. A low threshold value produces a lighter image, and can
be used to subdue backgrounds and subtle, unneeded
information. A high threshold value produces a darker image,
and can be used to help pick up faint images. Adjust the
threshold setting by dragging the Threshold sliding bar to the
left or right to achieve the desired threshold setting.
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Documenf
(Threshold: 230)

Normal Photo ) Document
(Threshold: 230)
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Brightness Adjusts the lightness or darkness of an
image. The higher the value, the brighter
the image. Drag the slider to the right or
left to increase or decrease the brightness.
The range is from -100 to +100.

Contrast Adjusts the range between the darkest and
the lightest shades in the image. The
higher the contrast, the bigger the
different grayscale. Drag the slider to the
right or left to increase or decrease the
contrast. The range is from -100 to +100.

Brightness: -50 Brightness: 0 Brightness: +50
(Normal)

-T:

|_ .':._-

5%

Contrast: -50 Contrast: 0 Contrast: +50
(Normal)
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Resolution A good control of the resolution results a
good detail of an image that scans. The
resolution is measured by dots per inch
(dpi). Normally, the greater the dpi number,
the higher the resolution and the image file
size. Be aware that greater resolution takes
more time to scan, and more disk space for
the scanning image. For your information,
an A4 size color image scanned at 300 dpi at
True Color mode consumes approximately 25
MB of disk space. A higher resolution
(usually means over 600 dpi) is only
recommended when you need to scan a
small area at True Color mode.

Choose a resolution value from the drop
down list. The default value is 200 dpi.
Available resolutions are 75, 100, 150, 200,
300, 400 and 600. Or you may choose your
desired value by clicking the box in the right
side of the drop down list and press the
arrow key to select your desired value and
then click the Add button to include it in the
drop down list. Note: The resolution is up to
300 dpi if an imprinter or a MICR reader is
installed or connected to the scanner.

A. f
- - !
5

Resolution: 75 dpi Resolution: 150 dpi
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Invert

Reverses the brightness and the colors in the
image. The default setting is Black on a White
background. Reverse mode is White on a Black
background. For color images, each pixel will be
changed into its complementary color at the
command of Invert.

"I am nok warthy bohave you enk=r mmy
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Scan
Source

Choice:

Auto Document Feeder: Used to scan
multiple pages.

Flatbed: Used to scan a single page. For
example, pages from newspaper clipping,
paper with wrinkles or curls.

Flatbed (book): Used to scan several
inside pages from book.

Automatic: Allow the scanner automatically
set its scan source. If Automatic is selected
and there is document in both the auto
document feeder (ADF) and the flatbed, then
the scan source will be automatically set to
ADF. If Automatic is selected and there is
document only in flatbed, then the scan
source will be set to flatbed.

Merge Two Sides into One Image:

If you have a sheet-fed duplex scanner with
front input tray, you can scan an A3 size
document with an innovative method. Thus,
fold your A3 size document into A4, and then
load the paper in the front tray. Choose
Merge Two Sides from the Scan Source
option and then the scanner is able to scan
both sides of your document and merge two
A4 images into one A3 image.

When you select Merge Two Sides into One
Image, the Cropping or Multi-feed function
will be disabled.

Note: This feature must be used with a
carrier sheet. Regarding how to load a
document with a Carrier Sheet, refer to
Section 4.6.2, Other Paper Selection.

Note the options vary based on type of
scanner.

4-21



User’s Manual

Note: If you have purchased a duplex sheet-fed
scanner, choose [Merge Two Sides] on the
[Scan Source], then the scanner is able to scan
both sides of your document and merge them
into a single image.

If "Merge Two Sides into One Image” is
selected, its choice will be available including
“Merge Horizontally”, “"Merge Vertically”, “Merge
Vertically (Back Side Flip)”. If the reverse side
of your document is upside down, choose
“Merge Vertically (Back Side Flip)” and the back
side will be automatically rotated 180 degrees
and merged.

Front
Side
Front Rear
Side Side
Rear
Side
Merge Vertically Merge Horizontally

Note the options vary based on type of
scanner.
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Color The purpose of Color Matching is getting the

Matching accurate color. This option uses the default
parameters (ICC profile) to adjust the colors
of the image.

Choice: None, Document, Photo

e None: Choose "None” to disable this
option.

e Document: Choose “"Document” if your
original contains pure text or a mixture of
text and graphic since it is an optimal
setting for regular business document.

e Photo: Choose “Photo” if your original
contains photo to reproduce your photo in
vivid color image.

Normal

After Color Matching
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4.3.3 Scanning color images

The following options are available for scanning color images.

Brightness
Contrast
Resolution
Invert

4.3.4 Scanning grayscale images

The following options are available for scanning gray images.

Brightness
Contrast
Resolution
Invert

4.3.5 Scanning B&W images

The following options are available for scanning B&W images.

Or

Binarization (Dynamic Threshold)
Resolution
Invert

Binarization (Fix Processing)
Threshold

Brightness

Resolution

Invert
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4.3.6 Editing Profiles

The Scanner Properties dialog box allows you to change and
save your frequently used scan settings into a profile. You can
edit these profiles by renaming or deleting them.

To add a new profile,

1. Customize your settings. (For example, change your
resolution, image type, cropping method, scan size, or
other scan settings.)

2. Click the Image tab and then choose “Profiles” to prompt
the “Edit Your Profile” dialog box.

. 1]

3. Click “Add” to enter the name of the profile and then
choose "Save”.

| Mol A i Bl
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4. The new profile will be saved and shown in the “Profiles”
dropdown list box.
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To load a profile,

1.

From the Image tab dialog box, choose your favorable
profile from the “Profiles” dropdown list box.

| W Wi -.._,._.
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Your favorable profile will be immediately loaded and
displayed on Scanner Properties dialog box.

To delete a profile,

1.

From the Image tab dialog box, click “Profiles” to prompt
the Edit Your Profile dialog box.

HI = = i

Choose the profile you want to delete from the dropdown
list box.

Click “Delete”. A Confirm message “Are you sure you want
to delete this profile?” is prompted.

Choose “Yes” to delete or “"Cancel” to quit.
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To rename a profile,

1. From the Image tab dialog box, click “Profiles” to prompt
the Edit Your Profile dialog box.
| e W, P ==
Lig
2. Choose the profile you want to rename from the dropdown
list box and then click the Rename button.
3. Enter new name for the profile.
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4. Choose "Save” to save the new profile or "Cancel” to quit.
Note:

The preset default profiles include Flatbed, Simplex-B&W,
200 dpi, Simplex-Gray, 200 dpi, Simplex-Color, 200 dpi,
Duplex-B&W, 200 dpi, Duplex-Gray, 200 dpi, Duplex-Color,
200 dpi. If you have a simplex or a sheetfed scanner, the
duplex or the flatbed option will not be available.

If any setting for a current profile has been changed, a [*]
sign will be marked before the name of current profile, for
example, [* Duplex, Color, 200 dpi]. If desire, click the
[OK] or [Scan] button and a dialog box will be prompted to
let you save the new profile.
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4.4 The Compression Tab

The Compression tab allows you to compress your scanned
image and choose the level of compression. Bi-tonal images
are normally compressed using CCITT standard called Group 4
(G4). Color and grayscale images are often compressed using
JPEG technology. Move the JPEG Quality slider to the right or
left to increase or decrease the level of compression. Note the
greater the compression level, the lower image quality. Default
is 50%.

Note that the compression depends on your image editing
application. If your image editing application does not support
the type of compression format, then either a warning message
will appear or the image quality of the compressed file will not
be acceptable.

JPEG (Joint Photographic Editor Group). This group developed
and lent their name to a file compression standard for color and
grayscale images that is widely used by scanners, and software
applications. On Microsoft Windows-based systems, a file with
the extension .jpg has normally been compressed using this
standard.

For scanning color or gray images, the following compressions
are available:

. None

. JPEG

For scanning B&W images, the following compressions are
available:

. None

. G4
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The Compression tab dialog box
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Compression:

To complete your scan at a rated speed, the scanned image is
compressed by default during transmission. However, if you
wish to obtain the highest image quality, you can choose to
uncompress the image data before it is output.

Scanned Scanned
Image Image 3
: Image Editing
Scanner Scanner Driver —_—
— Application

To Application:

Choose if you wish to compress the image data and transfer it
from the TWAIN driver to the application. Note Bi-tonal images
are normally compressed using CCITT standard called Group 4
(G4). Color and grayscale images are often compressed using
JPEG technology. Move the [Image Quality] slider to the right
or left to increase or decrease your image quality. Note the
greater the image quality, the lower the compression level.
Default is 50%.

Note that the compression depends on your image editing
application. If your image editing application does not support
the type of compression format, then the image of the
compressed file will look abnormal.

From Scanner: (Note: The availability of this feature
varies due to scanner model.)

Choose if you wish to compress the scanned image and transfer
it from the scanner to the TWAIN driver.

Choice: Uncompressed, *Best Image Quality (Low Compression
Level), Better Image Quality (Normal Compression Level),
Normal Image Quality (High Compression Level). (*: Factory
Default)
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4.5 The Color Dropout Tab

4.5.1 Color Dropout Selection

The [Color Dropout] tab allows you to select either green, red,
blue, or a color of your choice to remove the details of the
selected color from a scanned image. This feature is used to
sharpen your text when using OCR (Optical Character
Recognition) software. Note this feature applies only to the gray
or black and white image.

Choice: None, Auto, Remove Red, Remove Green, Remove
Blue, Custom

- None: Does not remove any color.

- Auto: Automatically outputs the image with the details of
the primary color removed.

Remove Red/Remove Green/Remove Blue: Outputs the
image with the details of the specified color removed.
Custom: Specify the color you wish to remove by entering
its RGB (Red, Green, and Blue) value respectively.

Advanced Options:

- Quality Mode: Range: 0~20. Default: 10
When [Quality Mode] is selected, you can determine the
color to be dropped out using the [Filter Threshold] slider. A
lower value will drop more of the selected color out, while a
higher value will leave more of the selected color in.

- Normal Mode: Use an optimized setting to determine the
color.
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Remove Green (quality
mode: Threshold: 18)

Preview the color dropout result:

To preview the color dropout result, please follow these steps:

1. Click the [Scanner Properties] icon () on the upper
left corner, and choose [Tab] to show available tab

names.

Choose [Preview] to show the Preview tab.

Click the [Preview] tab to show the Preview page.

4. Load your document to the scanner and click the
[Preview] button to get a preview image.

5. On the [Image] tab, click [Gray] or [Black and White]
image mode and then choose [Custom] on the [Color
Dropout] tab. A [Preview window] button will be

displayed.

6. Click the [Preview window] button to prompt the
[Preview] window with the previewed image.
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Move your cursor over the preview image. Your mouse
cursor now becomes an Eyedropper.

Click to select a color which you wish to remove.

Click and hold your mouse button to view the result
after removing the specified color. If the result is
satisfactory, click [OK] to close the Preview window.

The Preview Window The Color dropout result
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The Color Dropout dialog box
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To select a color on the Color palette,

1. Click the Color p—— = =
Dropout tab from = -_“ — :-
the Scanner iy
Properties dialog st
box. —

2. Choose Gray or o rereCTT =
B&W from the s ql:l
Image Selection
box and click —

“Custom” from the E

Color Dropout -
drop-down menu. - =

The Color palette o

appears. . —_—
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3. Move your cursor
over the palette. The
cursor becomes a
cross sign.

- - -

e

4. Click to choose a color. The RGB values are changed
simultaneously.
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4.6 The Paper Tab

The Paper tab allows you to define values relating to image
output (i.e., Auto Crop or not, Scan Area, OverScan, Multi-Feed
Detection).

S - —
o — E—— -

ST - F=

The Paper tab dialog box
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4.6.1 Cropping

Cropping allows you to capture a portion of the document
being scanned. Choice: Automatic, Automatic (36"),
Fixed to Transport, EOP (End of Page) Detection,
Automatic Multiple, Relative to Documents.

Options Description

Automatic Automatic adjusts the cropping window
according to different document sizes and
automatically straighten a skewed
document. Use this option for batches of
mixed-sized documents.

Automatic Automatically adjusts the cropping window
(36") according to different document sizes
smaller than 36" and automatically
straighten a skewed image. Use this option
for batches of mixed-sized document.

Note: The availability of this feature
varies due to scanner model.

Fixed to This feature allows you to define the area
Transport or zone to be imaged. Use for batches of
same-sized documents. If you select this
option, you can use the arrow keys to
define the x and y offset values, width and
length to redefine your scanned area. The
Display window will show image placement
as you change the values.

EOP (End of | This feature allows you to define the area
Page) or zone to be imaged. Use for batches of
Detection same-width but different length
documents. If you select this option, you
can use the arrow keys to define the x and
y offset values, width and length to
redefine your scanned area. The Display
window will show image placement as you
change the values.
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Automatic This option allows you to place various
Multiple sized documents such as photos, ID Cards,
or business cards on the flatbed (if
available) and lets you create multiple
individually cropped images in one scan.
Note: To correctly create multiple images,
please make sure there is at least 12mm
(0.5") of space between each document.
Relative to This option allows you to crop different
Document areas on your documents and deliver these
images in B&W, Gray, or Color separately.
For example, there are applications which
require you to store the entire document in
B&W and a part of the document in color to
save storage space. This is useful for
documents where a photograph or
sighature appears in a consistent area on
the document such as resumes, and so on.

The following options are only available when Fixed to
Transport is selected.

. X-Offset — the distance from the left end of the
scanner to the left edge of the scanning area.

. Y-Offset — the position from the top end of the
document to the top end of the scanning area.

. Width — the width of the scanning area.
. Length — the length of the scanning area.

. Center: automatically calculates the x-offset for center-fed
feeding based upon document size selected.

. © — relocate the scan area by click the arrow key on
the cross sign while retain the scan size. View the result
from the Display window.
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The Adjustment option is available when Automatic is
selected.

Adjustment —adds a positive/negative margin value
Top/Bottom or toward left/right of the image. []
Adjustment is used when the automatic document feeder is
used. Adjustment reduces the possibility of corner clipping
on skewed images. To set Adjustment values, use the
UP/Down buttons to select where you want to apply
Adjustment values: Top/Bottom or Left/Right, and then
select the amount of inches/mm/pixels applied. Select a
value within the range of 0.00 to 1.00 / -1.00.
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Relative to Document: (used for batches of same-sized
documents)

This option allows you to crop different areas on your
documents and deliver these images in B&W, Gray, or Color
separately. For example, there are applications which require
you to store the entire document in B&W and a part of the
document in color to save storage space. This is useful for
documents where a photograph or signature appears in a
consistent area on the document such as resumes, and so on.

The following procedure describes how to reproduce the entire
document in B&W and a portion of document (picture) in color.

1. On the Paper tab, choose “Relative to Document” or “Fixed
to Transport” from the Cropping option.

2. Choose your scan size from the Scan Area option. The
selected scan size will be displayed in a red rectangular
box. This is also the scan size of your entire document.
(For example, ISO B5. If you have not chosen a scan area
and leave the selection as None, then the default area will
be the scanner’'s maximum.)

e — 5

== ; T Ared
rectangular
box
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3. Click the Preview tab to display the Preview window. A
black rectangular box appears to indicate the max. scan
size your have just selected.

3 = = =

The Image —
Selection
Box
— 71— A black
rectangular
box

4. Click the Preview button to view the entire image in low
resolution to correctly crop your relative scan area.

The Preview
Image

/— The Preview
Button

5. Select image type from the Image Selection box. The
selected image will appear in highlighted color. (For
example, Front Color)

6. Place your cursor on the Preview window and click your left
mouse button. A cross sign will appear as illustrated.
Create your relative scan size diagonally by dragging the
left mouse button to your preferable size. The selected
area will appear in a red box as illustrated.
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A Cross T e
Sign | I rews -
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Check the B&W image from the Image Selection box to
scan the entire document.

Click the Scan button to start scanning the document in
two image types and sizes. (See the result in below.)

—
W"'- -

ok T

The entire document in B&W  The relative area in color
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4.6.2 Other Paper Selection

Carrier Sheet Mode:

Check this option to automatically crop the scan window
according to your document size when scanning non-standard
document (fragile, irregular-size document) with a carrier sheet
(optional). Note: The availability of this option varies due to
scanner model.

Loading Documents Using a Carrier Sheet

A Carrier Sheet is a plastic sheet specifically used for loading
non-standard document onto the scanner. It allows you to scan
document that can not be scanned in the regular way. Also,
documents larger than A4 size, such as A3 and B4, can be
scanned by folding in half, inserting into the Carrier Sheet, and
scanning in duplex mode. You can also scan documents that
can be damaged quite easily such as photographs, or irregular
size documents that are difficult to load directly such as

clippings.
To scan document using a Carrier Sheet,

For documents larger than A4 /Letter size, such as A3

a. Fold the sheet to be scanned in half.
b. Fold the sheet tightly and smooth out crease. Otherwise,
the sheet may be skewed during scanning.

1. Open the Carrier Sheet and place the document
inside.
Align the top of the document to the top of the Carrier
Sheet (the printed area).
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For documents larger than A4/letter size, such as A3
Align the top of the document to the top of the Carrier
Sheet (the printed section) and the folded portion to the
right edge of the Carrier Sheet so that the document fits
into the Carrier Sheet at the upper corner.

For non-standard document
Center your document in the Carrier Sheet.

a VAN e )

7N
Load the Carrier Sheet with the gray section (printed
section) facing downwards.

Adjust the paper guides to the width of the Carrier Sheet.
Adjust the paper guides so that there is no space between
the guides and the Carrier sheet. Space between the
guides and Carrier Sheet may cause the Carrier Sheet to
become unaligned during scanning, and skew the
scanned image.

Start the scan.
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Notice:

e [Carrier Sheet] is available for the models that support the
Carrier Sheet.

e Some functions are disabled when [Carrier Sheet] is
checked.

e This option may not work properly on some applications.

Scan Area

Choose your desired paper size with the drop-down list box. Or
you may select a custom paper size by clicking the Scan Area
box and then click Add to include in the choice.

Choices are listed below:

None
US Letter- 8.5"x 11"

US Legal - 8.5"” x 14"
ISO A4 - 21 x 29.7 cm
ISO A5 - 14.8 x 21 cm
ISO A6 - 10.5 x 14.8cm
ISOA7 -7.4x10/5 cm
ISOB5-17.6 x 25 cm
ISOB6 -12.5x17.6 cm
ISOB7 -8.8x12.5cm
JIS B5 - 18.2 x 25.7 cm
JISB6 -12.8x 18.2cm
JISB7 - 9.1 x12.8cm
Scanner Maximum
Long Page (<118")
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Long Page (<118”):

When you need to scan documents whose length exceeds
scanner maximum, please choose Long Page. Note if Long
Page is selected, the Multi-Feed Detection will not be
available. (Note: This option and the maximum allowable
document length vary due to type of scanner.)

When Long Page (<118") is selected, be sure to specify your
document size in the Length and Width field.

Notice when scanning long page document:

1. Pull out the extension in the ADF Paper Tray.

2. Secure enough space around the Output Tray to prevent
the ejected paper from falling off the Output Tray.

3. To ensure the performance, in color mode, set the
resolution to be 300 dpi or lower; in Black and White
mode, set the resolution to be 600 dpi or lower.

4. Depending on your system environments, application, or
your specified paper size, there may be insufficient
memory to perform scanning.

OverScan

Overscan allows you to add a specific margin at top and bottom
or right and left (Options vary based on the type of scanner) of
the edge of the image. This is used to reduce possible corner
clipping on the skewed images and often applied to a batch of
skewed document to be scanned in the auto document feeder.
Select a value between 0 and +5 mm. Note the overscan
result will not be shown in the Display window and that the
availability of the function varies based on type of scanner.

Pre-Feed

Choice: Enable, Disable. If enable is selected, you can set the
amount of time the scanner starts pre-feeding your paper after
your documents has been loaded into the feeder. The default is
disable. Note: The availability of this option varies due to
scanner model.
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Transport Timeout

Set the amount of time the scanner will wait and then start
auto scan after the first scan job is completed. If you have
many separate documents need to be scanned at the same
scan settings, this feature is especially useful. The default is 0.
The value ranges from 0 to 30 seconds.

Note:

1 Within the specified timeout period, if you load your
document to the feeder, the scanner starts scanning
automatically.

2 If your scanner has a flatbed option and you place your
paper on the flatbed, after the timeout period, you need
to click the Scan button on the TWAIN user interface to
start scanning.

Tray Position

Specify number of sheets loaded in the paper tray in order to
reduce the time to lift up the tray. Choice: 50, 125, 250, 375,
500 sheets (default).
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Background
Setting

This option allows you to set your scan
background. Choice: White Background,
Black Background.

Note: For a sheet-fed scanner with an auto
document feeder, this option is currently
available only in the “Auto crop” mode. For a
scanner with a flatbed platen, this option is
available either in the “Auto crop” or the
“Fixed to Transport” mode.

.

| |
White Background

[
Black Background
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4.7 The Multi-Feed Detection Tab

Multi-Feed Detection

Multi-Feed Detection allows you to detect overlapped document
that go through the auto document feeder. Multi-Feed usually
occurs due to stapled documents, adhesives on documents, or
electro-statically charged document. Note : The availability of

the function varies based on type of scanner.

[ i BoapEe— ;;.u.

| gy S [ — e
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Additional Length Detection

Additional Length Detection allows you to define the length of
document being multi-fed. This value indicates the additional
length exceeding your scan area. The Display window will show
the size of the document as you change the value. A value of 0
indicates no additional length detection. The Additional Length
Detection is best used when scanning same-size documents in
the auto document feeder.

Ultrasonic Detection

Ultrasonic Detection allows you to set overlapped document by
detecting paper thickness between documents. Choice: Left,
Middle, Right

Specify the area in a document where you wish to enable multi-
feed detection through ultrasonic sensors.

Left Middle Right

Sensitivity (Ultrasonic Detection): Adjust the sensitivity level of
the multi-feed detection through ultrasonic sensors. Choice:
Auto (fit for normal document), Low, Medium, High. For
example, choose [High] when you have a stack of thin paper
(e.g. 28g), choose [Medium]/[Low] when you have a stack of
thick paper (e.g. 1289).
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e Stop Scanning after Multi-Feed

- If this is not selected, the scanner will continue scanning the
rest document though multi-feed is detected. After the
entire document has been scanned, a multi-feed dialog box
will be prompted to indicate the page number which has
been detected multi-feed and need to be rescanned.

- If this is selected, the following options will be displayed.

Stop: If this is selected, the scanner will stop scanning after a
multi-feed is detected. No further dialog box will be prompted.

Ask: If this is selected, the image of the page which has been
detected multi-feed will be displayed and three options are
provided.

= Continue Scan: If the image of the multi-feed
page is acceptable, select
[Continue Scan] to continue
scanning the rest pages.

= Continue If the image of the multi-feed
Scan(Discard page is not acceptable, select
Image): [Continue Scan (Discard

Image)] to scan the rest pages
yet the multi-feed page will be
ignored and you need to rescan
the page again.

- Stop Scan: The scanner stop scans. Remove
the remaining pages in the
scanner. Remove staples or any
adhesive tapes on your
document. Or fan your document
and rescan the rest pages.
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e Multi-Feed Alarm

If a wave file is added, the scanner will make a sound

alarm if multi-feed is detected yet no Warning dialog box
will be displayed.

How to add the sound alarm:

1. Click the Browse button on the right side of the speaker icon.
The Open dialog box appears.

2. Choose your wave file.
3. Click the Open button. The wave file is added.

Units

Defines the primary measurement system. Inches,
Millimeters, and Pixels are available.
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Specifying an Area to Be Detected Multi-Feed or Not to
Be Detected Multi-feed

*The availability of this function varies according to your
scanner type.

If you need to scan a document with an attachment such as a
sticky note, receipt, or a photograph while multi-feed detection
is enabled, the scanner may falsely recognize this as a multi-
feed error and stop the scan. To scan this type of document, an
advanced option is provided. There are two modes in this
advanced function. You can manually specify an area to be
detected as multi-feed or not to be detected as multi-feed. Or
you can scan your document to let the scanner memorize the
area to bypass multi-feed.

__| Sticky Note

| Receipt

ﬂ]ﬁ | Photograph

Document with attachments

e Manually Specifying an Area

To specify an area to be detected multi-feed,

1. Click the [Multi-Feed] tab, and then choose [Ultrasonic
Detection]>[Advanced].
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.............................
.................

Make sure the [Selected Range] is checked.

3. On the [Selected Area] drop-down list box, choose
[Enable].

4. Specify your area by lowering the top of the default
highlighted area or lifting the bottom of the default
highlighted box as shown in below.

T Top

Multi-Feed
Detection Area

Bottom

5. Click [OK] to save the setting. The selected area will be
detected as multi-feed.

To specify an area NOT to be detected multi-feed,

1.  Click the [Multi-Feed] tab, and then choose [Ultrasonic
Detection]>[Advanced].

2. Make sure the [Selected Range] is checked.
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3. On the [Selected Area] drop-down list box, choose
[Disable].

4.  Specify your area by lowering the top of the default
highlighted area or lifting the bottom of the default
highlighted box as shown in below.

S
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Bypass Multi-Feed
Detection Area

Bottom

5. Click [OK] to save the setting. The unselected area will
not be detected as multi-feed.

e Intelligent Multi-feed

You can create areas not to be detected as multi-feed by
scanning your paper and let the scanner memorize these areas
to be bypassed as multi-feeds. Up to 5 sets of patterns can be
set. Follow these steps to create or edit the profiles not to be

detected as multi-feed,

1.  Click the [Multi-Feed] tab, and then choose
[Advanced]> [Intelligent Multi-Feed (Bypass Multi-
Feed).
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2. Click [New]. An [Insert your paper] dialog box will be
prompted. Insert your paper with attachment on the paper
to the scanner and click [Yes]. The scanner begins
feeding the paper and the area for the attachment will be
memorized by the scanner.

3. A Naming the profile dialog box will be prompted. Enter
the name of the profile to bypass the multi-feed and click
[OK].

4. The intelligent multi-feed profile will be saved.

To rename or delete the current profile,

1. Select a current profile you wish to rename or delete.

2. A dialog box will be prompted to enter your name or
confirm your request.

3. Enter your new name and click OK or confirm your request.

To export your current profiles on the scanner,
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Click [Export] and then enter the name of profiles on the
[Export Profile] dialog box. Click [Save] to save the profiles
into an .imf file. The .imf file will be stored in the following
path.

C:\ProgramData\xxxx (xxxx indicates your scanner model

name)

To import your current profile to another scanner,

Click [Import] and then choose the file. Click [Open] and the
previously stored profiles will be duplicated on the [Profiles]
drop-down list box.
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Staple Detection

The Staple Detection feature automatically halts the scanning
process when an unremoved staple is detected. Left
undetected, staples could cause errors that compromise the
document, cause jams, or damage the device.

The scanner has sensors on both sides of the feeding slot to
detect feed errors when the documents with staple is lifted up.

Note:

The corners of document to be fed toward the feeder can not be
detected accurately because these corners of document are not
lifted up high enough to be detected.

Item Description

E Staple Detectors

Indicates undetectable areas.

Indicates detectable areas.
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4.8 The Preview Tab

The Preview tab allows you to preview (a low-resolution scan)
your image before final scan. This preview image lets you
allocate your scan area. You can choose your scan area by the
“Scan Area” drop down list box or placing your cursor on the
Display window and dragging it diagonally on the Display
window. Then, a red rectangle box will appear to indicate the
selected area.

Note: If you choose “Automatic Cropping” on the “Paper Tab”,
then to select a scan area on the Preview tab is not allowed.
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The Display
Window

The Preview Tab
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4.9 The Enhancement Tab

The Enhancement tab allows you to set following additional
image processing settings.

e gy ==
g | P | Bl o) Cotntind | Parsin et Gy, | le—

B b P

b grasd m—

[age ™8

-._gu [y —

Fer Wi arar

[ 1. —

A e [ ferw

o e

BT ! - | L

The Option tab dialog box
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Punch You can remove punch holes from the output

Hole scanned image when scanning punched document.

Removal Note the availability of this feature varies
depending on your scanner model.

Original Output image

Punch holes can not be removed when:

e Resolution is set lower than 150dpi

e The hole is near the edge of the document

e The holes are not aligned along the edge of the
document

e Punch Hole Removal is available only when
“Auto Crop” is enabled. If either “Fixed to
Transport”, "EOP (End of Page) Detection”,
“Automatic Multiple”, “Relative to Documents” is
selected from the Cropping option on the Paper
tab, the Punch Hole Removal option will be
disabled.
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Shadow Removal When "Flatbed ; on the "Scan
Source ; option is selected on the
"Image  tab, the "Shadow
Removal | option will be enabled. Click
to remove the shadow on the book spine
when scanning a book.

L i
|- _-i-_ . 'S N
Before Shadow Removal After Shadow Removal

4-64



User’s Manual

Background Processing: The [Background Processing]

option allows you to smooth background color or remove it to

make image clearer. The option is especially useful for

documents with color forms such as invoices.

Choices: None (default), Smooth, Removal

- None - no background processing will be performed
(default)

- Smooth - produces images with a more uniform
background color. This option improves image quality.

- Removal - identifies the background color and then
removes it.

Sensitivity: Choice: 0, 1, 2, 3, 4. Default: 0
- The higher the value, the more background color will be
kept.

Mode: Auto, Moiré

If [Smooth] is selected in the [Background Processing]

option, then the choices for the [Mode] option includes Auto,

and Moiré.

- Auto - uses the factory preprogrammed mode to proceed
background smoothing.

- Moiré - Remove the moiré patterns that appear on the
background of the image when scanning printed material.

If [Removal] is selected in the [Background Processing]

option, then the [Mode] option will be replaced with [Fill

Color]. Choices: White, Auto.

- White - identifies the background color and substitutes it
with white.

- Auto - identifies the background color and substitutes it
with the color of the largest background zone.
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Background Processing:
Removal
Fill Color: White

Note: Background color in small zone will not be processed or

removed.
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Edge Check White or Black if you wish to add white or
Fill black edge on the border of your scanned image.
Enter the value from 0 to 5 mm. Default value is 0.

Original Edge Fill: 5mm (Black)
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Despeckle

Occasionally small dots or specks appear in the background of a
scanned image. Remove unwanted speckles provides a cleaner
image for OCR (Optical Character Recognition) processing, and
also helps to reduce compressed file size.

Define the speckles (also known as image noise) you wish to
remove by specifying its number (size) and radius (range). The
measuring unit is pixel. The higher the number, the more
speckles will be removed.
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After Despeckle
(noise number:22, noise radius:10)

Note:

o The function is currently available for Black and White
image only.

o To scan at rated speed, it is recommended to set the noise
radius up to 10 pixels.

4-68



User’s Manual

Line Removal: When Black and White image mode is
selected on the [Image] tab, the [Line Removal] option will
be enabled. Line Removal erases lines on the image and then
reconstructs characters so the OCR (Optical Character
Recognition) accuracy can be improved.

Choices: None, Form, Horizontal, Vertical
None - the default mode which does not remove any line.
Form - remove any form in the document.

Horizontal - select [Horizontal] and then enter the length of
horizontal line to remove only the horizontal line exceeding
your specified length.

Vertical - select [Vertical] and then enter the length of
vertical line to remove only the vertical line exceeding your
specified length.
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Remove Horizontal Line Remove Vertical Line
(over 30 mm) (over 70 mm)
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4.10 The Rotation Tab

The Rotation tab allows you to set the following image rotating
options:

TR |
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Rotate Choose the rotation angle from the drop down
Image list if you wish to rotate your scanned image.

Choice: None, 90°CW(clockwise),
90°CCW(counter clockwise), 180°, Auto
based on contents. Auto rotate every
even page.

123 —

[~

)
Original Rotate 90°CW
L -
o ¢ C 1
Rotate 90°CCW Rotate 180°
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Auto based on contents: Automatically

rotate images

based on the contents of

document. When " Auto based on

contents | is selected, its modes will be
enabled to let you select more options.

Mode: Quick,

Full Text, Complexity

Quick - the default mode to let you rotate
images at the fastest speed.

Full Text - the enhanced mode for
documents with mixed text orientation.

Complexity - the enhanced mode yet at the

slowest speed

for document with complex

image or text orientation.

Auto rotate every even page:
Automatically rotate 180° on every even
page. This is especially useful when you scan
the inside pages from a book. As a result, if
you choose “Flatbed (book)” from the “Scan
Source” option, “auto rotate every even page”
will be selected as default.

Note: This option varies based on type of

scanner.
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Document with various
text orientations

Document with dark or
complex background
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Split
Image

By splitting an image, two separate images are
created horizontally or vertically. This is useful
for documents containing two pages per image
when you want to save them as two images
(one page for one image). Choice: None,
Horizontal, Vertical. Default is None.

Horizontal: Divide one image into the upper
half and the lower half.

Vertical: Divide one image into the left half and
the right half.

* I

Split Horizontally Split Vertical
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Flip Side Select “fanfold” to rotate the image of the
Rotation reverse side to 180 degrees.

This is applied to double-sided document
which are viewed in portrait are sometime
fed into the scanner in landscape or vice
versa.

Choice: Book, Fanfold.

If "Book” is selected, the image of the
reverse side will not be rotated.

The following illustration shows the documents which should
be viewed in portrait are fed into the scanner in landscape
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Image Check the Mirror box if you wish to reverse the right
Control and left side of your image.
Option

The Mirror Effect
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4.11 The Separation Tab

The Separation tab allows you to enable the detection engine to
detect the blank page, barcode, and patch code and then notify
the software application which supports document separation to
separate your multi-page documents. Choices: Blank Page
Removal, Barcode Detection, Patch Code Detection.

Blank Page
Removal

Choices: None, Blank Page Removal Threshold,
Image Size.

None - Do not remove the blank pages.
Threshold - Move the slider to the left or right
to define your threshold for the blank page.
Image Size - Range: 1~ 10000 KB. Specify
your desired image size to detect the page as a
blank page. For example, if 3 KB is selected,
any page less than 3 KB will be recognized as
blank page.
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Barcode Check [Enable] to detect barcode and notify

Detection the software application for advanced
processing. Please note the whole document
will be checked and no specific detection area
needs to be designated.

When the bar code has been detected successfully - a file
[avbarcode.ini] will be created and stored in the following path:

Windows XP: C:\Documents and Settings\All Users\Application
Data\%PRODUCTNAME%

Vista, Windows 7, Windows 8, Windows 10:
C:\ProgrambData\%PRODUCTNAME%

Barcode Types:
The following barcode types can be detected.

Two-dimensional codes

e Aztec

e DataMatrix
e PDF417

e QR Code

One-dimensional barcodes:
Code 39
Code 93
Code 128
EAN-8
EAN-13
UPC-A
UPC-E
Codabar
GS1 DataBar
MaxiCode
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Barcode Zone:
Specify the barcode zone to be detected.

Select TAIll; to checks the whole document and detects

barcodes. Or you may speed up the process by specifying a
detection area since only the specified area is checked.

Choice: All, Top, Bottom, Left, Right, Bottom Right,
Bottom Left, Top Right, Top Left

Choice for barcode zone on a page:

All Top Bottom Left Right

Bottom Bottom Top Right | Top Left
Right Left

Note:

° Recommended resolution: 200~600 dpi for regular
barcode, 300~600 dpi for QR code

° Skewed barcodes may not be recognized correctly.

° Using the same sheet repeatedly may decrease the
recognition accuracy due to accumulated dirt on the sheets.
If the sheet is not recognized correctly or gets smudged,
replace it with a new sheet.
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Patch code Detection:
Check [Enable] to detect patch codes and notify the software
application for advanced processing.

A patch code is a pattern of parallel, alternating black bars and
spaces (i.e. a barcode) that is printed on a document. Patch
code sheet is most commonly used as a document separator in
a stack of document.

You can find various sizes of patch codes (PDF) by choosing
[Start] menu>[All Programs]>[Avision Scanner
Series]|>[Patch code] in succession.

Simply print the PDF file to produce the patch code sheet.
Insert the patch code sheets to wherever you want the file to
separate.

Patch code sheet

Notes to print the patch codes:
° Use blank white paper.

e  Set the scaling to 100%. The sheet is not recognized
correctly when printed in a size smaller than the original.

° Do not use toner saving mode. The sheet is not recognized
correctly when the print is too light.

e Do not use thin paper in order to avoid bleed-through from
the back.

e When you copy a patch code sheet that you printed out,
make sure to copy by the same size and brightness as the
original copy.

° Use the same sheet repeatedly may decrease the
recognition accuracy due to accumulated dirt on the sheets.
If the sheet is not recognized correctly or gets smudged,
replace it with a new sheet.
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4.12 The Setting Tab

The Setting tab allows you to set the following settings:

]
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.
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.
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|

The Setting tab dialog box

Energy Saving
Control

Check the Enable Energy Saver box
and move the slider to set the amount
of time to start the energy saver after
your last action. The range is from 1 to
60 minutes.

Enable Power
Off

Check the Enable Power Off box and
move the slider to set the amount of
time to automatically turn off the
scanner after your last action. The
range is from 1 to 480 minutes. The
default is 240 minutes (4 hours). Note
the value of “Power Off” has to be
greater than or equal to the value of
“Energy Saving”.
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Cache Mode: None, Page Number, Memory
Size.

This option allows you to assign a specified
memory size from the available RAM to
process the image data. By specifying a
smaller memory size, you can free more
memory for other applications you are
running. By specifying a larger memory
size, you can have more memory to process
the image data especially when you have a
large amount of documents needed to be
scanned.

You can also specify your memory size by
the page number. For your information, an
A4 color document scanning at 300 dpi
consumes approximates 24MB.

Image Count

When the selected cache mode is “none”,
the image count option allows you to assign
number of pages you need to scan. For
example, if you wish to scan the first two
pages, simply move the page slider to 2,
and the scan action will be stopped when
the scanning of the first two pages have
been completed.

Sleep Mode | Check the Sleep Mode box and move the
slider to set the amount of time to start the
sleep mode after your last action. The
default is 15 minutes and the range is from
1 to 60 minutes.
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Show Scanning | Check and the scanning progress bar
Progress will be shown during scanning.

Show Warning Check to show the warning messages
Message such as “"ADF pad count exceeds 50,000
scans (the number varies based on type
of scanner). Please replace the ADF pad
and reset the pad count.”

Thin Paper In [Thin Paper Mode] , the scanning

Mode speed will be slowed down to avoid
paper jams and thus damage the
paper.

Save Settings Check to save your scanner properties
after Closing settings after leaving the dialog box.
Next time when you open the Scanner
Properties dialog box, the previously
saved settings will be shown.
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4.13 The Imprinter Tab

The Imprinter tab allows you to print alphanumeric characters,
date, time, document count and custom message on your
scanned image if digital imprinter is selected or at the back of
your document if external imprinter is selected.

Choice: External Imprinter, Digital Imprinter. If you have
installed an external imprinter, choose external imprinter. If
you do not have an imprinter, choose digital imprinter. Note
External Imprinter provides a vertical and rear-side print
capability while digital printer provides a horizontal and front-
side print capability.
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Contents

Print All Check Print All to automatically print the
text at all pages of your documents.
Uncheck Print All to print the text for the
first page of your documents only.

Custom Enter your custom text to be included in your
print string.

Counter Show the document count for the scan
session. This value is increased sequentially
by the scanner.

Date/Time Choose if you wish to include the date and
time in your print string.

Format: YYYYMMDDHHSS For example,
20090402170645-check0001 indicates year,
month, date, hour, seconds, your custom text
and the counter.

Custom Choose your desired font.

Font Choice: Normal, Fixed Width
Fixed Width (Mono spaced) fonts have a
fixed character spacing. So each character
occupies the same width.

Advanced
Font Choose your font attributes. Choice:
Attributes Normal, Underline, Double, and Bold.

4-84



User’s Manual

String Choose your string orientation.
Orientation | Choice: Normal, Rotated, Vertical,
Vertical Inversion, 90 degrees CW, 90
degrees CCW

2eQ 102
2010abc

Normal Rotated

oOogwo—=okM
NOoO—O @O

Vertical Vertical Inversion

24eQ10¢
2010abc

90 degrees CW

90 degrees CCW

If you check the digital imprinter to stamp
text on your scanned image, the illustration of
normal and rotated string is shown below:

2010abc 2qE010C
Rotated

Normal
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Print Choose the position you wish to print your
Position string. Move the slider to the right to increase
the value or to the left to decrease the value.
Range: 0~355mm, default:0 mm

The value indicates the height from the
bottom of your paper to the last letter of your
string. This option is available only if an
external imprinter is installed.

0TO0ZC 29eT1000

| The value of
Print Position

|

Print Position (for digital imprinter)

Choose the position of your printed string. Choice: Top,
Middle, Bottom, Custom. If Custom is selected, enter the X
and Y offset value to specify the position.
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4.14 The Information Tab

The Information tab displays the following system and scanner
information.

The Information tab dialog box

The “"Report” button :

If you encounter any error message while using the scanner,
click the Report button. A report.txt file [Windows XP:
C:\Documents and Settings\All Users\Application
Data\%PRODUCTNAME%; Vista, Windows 7, Windows 8,
Windows 10: C:\ProgramData\%PRODUCTNAME% (C: system
drive)] will be generated. Please send this file to the nearest
service center for trouble shooting.
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The “"Reset Roller Count” button :

After scanning over a recommended number of pages (refer to
subsequent section 7.4 Replacing the ADF Roller) through the
ADF, the ADF roller may be worn out and you may experience
problems with document feeding. In this case, it is highly
recommended to replace the ADF roller with a new one. (Note
the replacement of the ADF roller has to be performed only by
authorized service center. Therefore, please return your
scanner for roller replacement.) After replacing the ADF roller,
click the "Reset Roller Count” button to reset the roller count.

Note :

The lifetime and the replacing procedure vary based on type of
scanner.
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5. ISIS Interface Operation

* Please refer to the preceding chapter, Scanner Installation, to
install ISIS scanner driver. You may start the supplied QuickScan
software application to scan via the ISIS user interface.

The ISIS driver operation method is similar to the TWAIN's.
Every function on the ISIS interface screen is briefly described as
below:
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Mode: Select one of scan modes, including B&W, gray, color
options.

Dither: 5 halftone levels available, can be disabled.

Dots per inch: Select your desired resolution.

Paper Size: Select your desired paper size.

Brightness: Adjust your scan image brightness or darkness.

Contrast: Adjust the range between the darkest and the lightest
shades in the image.

Default: Click to reset all settings.

Area: Select your desired scan area or position.
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6. Using the Buttons

The following picture shows the buttons and a function screen
on the scanner.

Function Screen

Function-Select

H— Button

| Cancel Button

(e Scan Button

o

I
Eat
Sty

6.1 Installing Button Manager V2

Button Manager V2 provides you an easy way to scan your
document and then link the scanned image to your designated
software application. All this can be done by a simple touch of
the button on the scanner. Yet, before you scan, it is
recommended to check the button configurations first to ensure
a proper file format and a destination application.
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6.2 Checking the Button Configurations before Scanning

1. Button Manager V2 runs from the system tray. After Button
Manager V2 and the scanner driver are properly installed,
Button Manager V2 is started and the Button icon will be
displayed on the system tray at the bottom right corner of

your computer screen.

01:41 Ph

following Button Panel.

51 iBod Prrige)

.i;| 1Huar §OCH)
i Eml

% Frifkes

= i

The Button Panel

T e

Left-click the Button Manager V2 icon to prompt the

This indicates the scanner model

The Function
Icon

(The number of
function icons
vary based on
type of
scanner.)
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3. The Button Panel shows the first five scanning buttons.
Right-click the button (function) you wish to check. The
Button Properties window appears.

E Name of the Selected Button
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If you wish to change the setting, use this window to reset
the setting for the file format, destination application, or
other scan settings.

4. Click the OK button to leave the window.
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6.3 Scanning From One Touch of the Buttons

1.

2.

pw

Adjust the paper guide for the width of paper and load the
document with their tops into the automatic document feeder.
Check the button name on the LCD screen to ensure if you
are selecting the proper scan settings and destination
application. (For example, if you wish to scan with Button,
“Scan to App”, which opens Microsoft Paint and displays the
scanned image in the window of Microsoft Paint, the LCD
screen should show “Scan to App”).

Press the Scan button on the scanner.

After the scanning is finished, the Microsoft Paint software
will be launched and the scanned image appears in the main
window of Microsoft Paint as below.

l‘i‘

FrrTE

Note:

1.

2.

For details information on how to use the Button Manager
V2, please refer to the user’s manual.

You may also use Button Manager V2 on your desktop by
starting Button Manager V2 from All Programs or double
clicking the Avision Scanner Utility from the Control Panel.
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7. Maintenance

7.1 Cleaning the ADF

From time to time, the Reverse roller and the Feeding Rollers
may be contaminated with ink, toner particles, or paper dust.
In this case, the paper may not be fed smoothly. Please follow
the following steps to clean the Reverse roller and the Feeding
Rollers to ensure the best of the scanner.

The Cleaning Steps:

1. Soak a clean cloth with some isopropyl alcohol (95%).
2. Pull the Handle and open the ADF cover with a light force.

3. Wipe the feeding rollers until they are cleaned.
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4. Close the ADF by pressing down on the center of the ADF
to return it to its original position until it clicks into place.

NOTE:

When the ADF has returned to its original position, make
sure that it is completely closed. Feeding errors may
occur if the ADF is not completely closed.
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7.2 Using the Clean Mode

When you perform cleaning for the feeding rollers in the lower
part of the scanner, the rollers need to be rotated with a light
force. Using the advanced [clean mode], the rollers can be
automatically rotated forward to help cleaning easier and
effective.

To use the Clean Mode to clean the rollers,
1. On the scanner, press V (Down arrow) to select [More

Settings] ﬂ. and then press the [Scan] button to confirm.

2. Use V to select [Clean Mode].

Tray Adjust
0 Information

1. USB > Clean Mode

Factory Default

3. Pull the Handle and open the ADF cover with a light force.
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4. Soak a clean cloth with some isopropyl alcohol (95%) and
wipe the feeding rollers until they are cleaned.

5.  When the cleaning is done, press the [Scan] button, the
feeding roller will be rotated a little automatically.

6. Repeat Step 5 for several time until all the surface of the
feeding roller are thoroughly cleaned.

7. Press the [Cancel] button to return to the main screen.
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7.3 Cleaning the Glass

1. Pull the Handle and open the ADF cover with a light force.

2. Wet a clean cloth with some isopropyl alcohol. (95%) If
accidentally use too much alcohol, be sure to wring out the
damp cloth.

3. Wipe the glass @ as illustrated below to side to rid the dust
or dirt.
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7.4 Cleaning the Ultrasonic Sensors

If the scanner sometimes fails to detect multi-feed via ultrasonic
sensors, it is possible that paper dust or dirt may be
accumulated on the surface of the ultrasonic sensors. Please
follow these steps to clean the sensors.

Press the ADF release button. Open the front door.

2. Wet a clean cloth with some isopropyl alcohol. (95%) If
accidentally use too much alcohol, be sure to wring out the
damp cloth.

3. Gently wipe the dirt and dust off the surface of the ultrasonic
Sensors.

' Note:

4 If it is difficult to clean, use a cotton swab.
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7.5 Cleaning the Reverse Roller

1. Soak a clean cloth with some isopropyl alcohol (95%). If
accidentally use too much alcohol, be sure to wring out the
damp cloth.

2. Pull the Handle and open the ADF cover with a light force.

A\
- V\.\ 3

3. Refer to the subsequent section 7.6.3 Replacing the Reverse
Roller on how to remove the Reverse Roller.

4. Hold one end of the roller assembly and gently wipe the
surface of the rollers with the other hand to remove the dust
of stains. Be careful no to scratch the surface of the roller.
Rotate the rollers until they are completely cleaned.
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5. Refer to the subsequent section 7.6.3 Replacing the Reverse
Roller on how to install the Reverse Roller.

6. Close the ADF by pressing down on the center of the ADF to
return it to its original position until it clicks into place.

A Warning:
° Do not use other detergent to clean the rollers. Other
detergents may damage the rollers and cause feeding errors.

e Gently wipe Only the Surface of the roller and wait until
the alcohol has been completed evaporated. Avoid
excessive alcohol flowing to the inner foam, leading to the
damage to the roller and causing feeding errors.

Do not let the cloth
moisturized with alcohol
touch the foam beneath
the surface of the roller or
let the excessive alcohol
flow into the foam.
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7.6 Cleaning the Imprinter

After frequent use, the waste ink will begin to accumulate on the
base surface of the print cartridge holder which can damage the
printouts. Make sure to maintain the base surface clean.

To clean the print cartridge holder,

1.  Wipe off any dirt or dust on the base surface of the Print
Cartridge Holder with a soft lint-free cloth.

2. Reinsert the Print Cartridge and close the Print Cartridge

Cover.
a. Grasp the tab of the b. Lower the locking lever of
Cartridge and insert the the Print Cartridge Holder
Cartridge into the holder until it locks in.

with the text side facing up
and the tab pointing to the
left.

=
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7.7 Cleaning the Printer Cartridge

Poor quality prints may occur due to blocked ink emission holes
in the Ink Nozzles of the Print Cartridge. Leaving the imprinter
unused for a long period of time can also cause the ink emission
holes to become blocked. When these holes are blocked, clean
the Ink Nozzles.

1. Remove the Print Cartridge.

a. Open the Print Cartridge b. Hold the tab of the
Holder by lifting up the locking cartridge and remove the
lever with your finger. Cartridge from its holder.

-.— L i Lo JE -
*i-iﬂb-l-#***i

2. Wipe the Ink Nozzle at the bottom of the Print Cartridge with

a clean, damp lint-free cloth lightly moistened with clean
distilled water.

Ink Nozzle

3. Once again, gently and slowly wipe the residual ink off of the
Ink Nozzle with a clean cotton swab.

4. Reinsert the Print Cartridge and close the Print Cartridge
Cover.
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' IMPORTANT:
=

e Once a print cartridge has been installed, do not
remove it from the machine and leave it out in the
open. This will cause the print cartridge to dry out,
and the device may not operate properly when it is
reinstalled. To maintain optimal printing quality, use
a print cartridge within six months of first use.

e Discard the used ink cartridge according to the local

laws and regulations regarding disposal of
consumables.
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7.8 Consumables and Replacement Cycles

The following table shows the consumables and their standard
replacement cycle.

CONSUMABLES REPLACEMENT CYCLE
Pick-up Roller 1,000K (sheets)

ADF Friction Roller 500K (sheets)
Reverse Roller 500K (sheets)

*The replacement cycles are estimated guidelines established by
testing 500 pcs of A4 sized woodfree or wood based paper (80
g/m?). The replacement cycle may differ due to paper quality,
print density, and paper type.

Note:

e Consumables must be replaced regularly. It is recommended
to purchase new consumables in advance so that they can be
replaced before the end of their life time.

e The replacement cycle is based on the use of A4 (80 g/m2
[20 Ib]) wood-free paper or plain paper. The actual cycle
varies according to the type of used paper and how
frequently the scanner is used and cleaned.

e Use only the specified consumables.

e To purchase consumables, contact the store where you
purchased the scanner or an authorized scanner service
provider.
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7.8.1 Replacing the ADF Roller

1. Pull the Handle and open the ADF cover with a light force.

2. Pull down the ADF Roller cover.

3. Pull down the tab to remove the ADF roller.
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4,

5.

6. Install the new ADF roller with the other side (opposing the
tab) facing up and then slide inwardly to the slot.
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7. Lift up and close the ADF Roller Cover as indicated.
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7.8.2 Replacing the Pick-up Roller

1. Pull the Handle and open the ADF cover with a light force.

2. Pull down the Pick-up Roller cover.

3. Press down the hook next to the right roller to remove the
right roller.
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3. Press down the hook next to the left roller to remove the left
roller.

Pick-up
Rollers

4. Align the direction of the center of the Roller to the end of
shaft and install the roller into the shaft.
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7.8.3 Replacing the Reverse Roller

1. Pull the Handle and open the ADF cover with a light force.

2.

Reverse Roller
Cover

3. Place your fingers in the center of the Reverse Roller
Assembly and lift it up to remove it from the slot.
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Remove the rollers from the shaft.
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e

Insert the left end of the new Reverse Roller to its slot as
indicated.
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7. Insert the right end of the new Reverse Roller to its slot. If
successful, a crispy snap-in sound can be heard.

8. Close the ADF by pressing down on the center of the ADF to
return it to its original position until it clicks into place.




NOTE:
e Note: Make sure the ADF is completely closed. Feeding
errors may occur if the ADF is not closed completely.

e Confirm that the Pickup Rollers and Reverse Rollers
are attached firmly. If not, paper feed errors such as
paper jams will occur.

7.8.4 Replacing the Print Cartridge

When printed characters appear light or missing characters are
evident, complete the following steps to replace your print
cartridge:

1. Open the Imprinter Cover.

_ 3\ i

2. Open the Print Cartridge Holder by lifting up the locking lever
with your finger.
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3. Hold the tab of the cartridge and remove the Cartridge from

its holder.
ol I , A 1 |
I
i
IMPORTANT:

e Once a print cartridge has been installed, do not
remove it from the machine and leave it out in the
open. This will cause the print cartridge to dry out,
and the device may not operate properly when it is
reinstalled. To maintain optimal printing quality, use
a print cartridge within six months of first use.

e Discard the used ink cartridge according to the local
laws and regulations regarding disposal of

consumables.
[ILR _“
eh— O

4. Open the box of the print cartridge and remove the
protective tape from the bottom of the cartridge.

N
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5. Do not touch the ink nozzles (@) or the gold contacts (®)
after the tape has been removed.

6. Grasp the tab of the cartridge and insert the cartridge into

the holder with the print side face up and the tab pointing to
the left.

7. Lower the locking lever of the Print Cartridge Holder until it
locks in.
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8. Position the print cartridge holder along where the document
will pass through.

——— @ @— 3

9. Close the Imprinter Cover.
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8. Troubleshooting

8.1 Clear Errors

If there is error during scanning, the red LED light will be
flashing and error condition will be displayed in the LCD screen.
Refer to the following table for a quick troubleshooting guide.

ERROR PROBLEM/ CAUSE

PROBLEM/SOLUTION

Paperjam

Check the location of
paperjam and then
remove the paper.

Cover opens.

Close the ADF cover.

Input Tray has
not been
opened.

Open Input Tray.
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More than two
sheets of paper
feed in the paper
path.

Stop the scan or
accept the image and
continue to scan.

Fan your document for
several times and
rescan.

No USB cable
connection

Connect scanner to
the computer with a
USB cable.

Staple Detection

Remove the staples
and then fan your
documents for several
times and rescan.

Failed to pick
paper

3. Fan the documents.

4. Load the document
with its edges
slightly touch the
paper guides.

Input Tray can
not be lifted up.

Call service.

Download
firmware failed.

Download the
firmware and try
again.
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Fan error. Check the fan in the
indicated location.
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More than
two sheets
of paper
are fed in
the paper
path.

4 e
R
g =

r. .1 If the image of the

H':. multi-feed page is
acceptable, select

Continue [Continue Scan]

Scan to continue
scanning the rest
pages.

r = | If the image of the

multi-feed page is
not acceptable,
select [Continue

gggrt]mue Scan (Discard

(Discard Image)] to scan

Image) the rest pages yet
the multi-feed
page will be
ignored and you
need to rescan the
page again.

r ... 7 | The scanner stop

I_"' | scans. Remove the

remaining pages
in the scanner.
Fan your
document and
rescan the rest
pages.

Use the Up and Down key (A/V)
to select your action.
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8.2 Clearing a Paper Jam

In the event of a paper jam, follow the procedures below to
remove the paper:

1. Pull the Handle and open the ADF cover with a light force.

2. Carefully pull the paper out of the ADF unit.
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Close the ADF by pressing down on the center of the ADF
to return it to its original position until it clicks into place.
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8.3 Questions and Answers

Question: | Why does not my scanner turn on?

Answer: | Ensure the USB cable is securely
connected to the scanner to the USB
slot in your computer.

Question: | Why doesn’t my computer
recognize my scanner when it’'s
connected via USB cable?

Answer: | Make sure the cable connection is
correct and secure. Restart the
computer if necessary.

Question: | Why there are strange lines on the
scanned document?

Answer: Please check the following:

1) Are there scratches on the original
or is the original clean ?

2) Remove any stains or dust from the
original before scanning.

3) Clean the rollers and glass with the
cleaning cloth (Refer to Chapter 7.)
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Question: Paper becomes jammed during
scanning.

Answer: 1) Open the ADF cover.
2) Pull out the jammed paper carefully.
3) Close the ADF cover.

Question: | More than one sheet of paper is fed
into the scanner.

Answer: 1) Open the scanner ADF cover.

2) Remove the multi-fed sheets.

3) Close the front door.

4) Flatten the corners and edges.
Loosen the paper before putting it
into the paper guide again.

5) Check the feeding roller condition.
If necessary, follow the cleaning
directions in section 7.1 and
perform the cleaning.

Question: | paper becomes skewed in the
scanner.

Answer: 1) Use the slide guide to keep the
paper path straight.

2) Check the condition of the feeding
roller. If necessary, follow the
cleaning directions in Section 7.1
and perform the cleaning.
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Question:

Why does my scanned image
always come out too dark?

Answer:

1) Please adjust the screen settings to
sRGB.

2) Please adjust the brightness
settings on the screen from
application software.

Question:

When I choose optical resolution to
be 600 dpi, the "auto crop" and
"deskew" functions will be
disabled.

Answer:

Since to perform auto crop and deskew
consumes great deal of system
memory, it is suggested if you wish to
perform "auto crop" and "deskew"
functions, please choose your optical
resolution to be smaller than 600 dpi
to prevent a error message.

8-9



8.4 Technical Service

Before contacting Avision, please prepare the following
information by referring to Section 4.14, The Information Tab:

m  Scanner serial & revision number (located on the bottom of
the scanner);

= Hardware configuration (e.g., your host CPU type, RAM size,
free disk space, display card, interface card);
The name and version of your scanning software application;
The version of your scanner driver.

Please call us at:

Headquarter

Avision Inc.

No. 20, Creation Road I, Science-Based Industrial Park,
Hsinchu 300, Taiwan, ROC

TEL: +886 (3) 578-2388

FAX: +886 (3) 577-7017

E-MAIL: service@avision.com.tw

Web Site: http://www.avision.com.tw
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US and Canada Area

Avision Labs, Inc.

5694 Stewart Avenue, Fremont, CA 94538
E-mail: sales@avision-labs.com

E-mail : support@avision-labs.com
http://www.avision-labs.com

China Area

Shanghai Technical Support Center

Room 410, Hesen Business Center, No. 1600 Yan'an West Road,
Changning District, Shanghai

TEL :4+86-21-62816680

FAX :+86-21-62818856

E-MAIL :sales@avision.net.cn

Web Site:http://www.avision.com.cn

Europe Area

Avision Europe GmbH
Siemensring 91

47877 Willich

Germany

Fax: +49 2154-88850-29
E-MAIL: support@avision.de
Web Site: http://www.avision.de

Espaco Brasil

Avision Brasil Ltda.

Rua Flérida, 1670 — CJ 122 - Cidade Mongoes, Séo Paulo-Brasil
Telefone: (11) 2737-6609

E-mail : suporte@avision.com.br

Web Site: http://www.avision.com.br
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9. Specifications

All specifications are subject to change without notice.
For the most up-to-date and detailed specifications, please refer
to our web site at http://www.avision.com

The scanner is doing an internal cleaning blowing air at every

power on.

Model Number :

Optical Resolution:
Scanning Modes:
ADF Capacity:
ADF Capacity:

ADF Weight:
Max. Document Size:

Min. Document Size:

Paper Weight:

Straight paper path:

U-Turn Paper Path:
ID Card Thickness:
Plastic cards:

Interface:
Power Source:
Operating Temperature:

Dimensions: (WxDxH):

Weight:

FT-2402H/AD8130z/
AD8130zP/AD8130zN/
AD8130zNP

600 dpi

Black & White / Gray / Color
Up to 600 pages

(A4, 80 g/m2) (20 Ib.)

Up to 300 pages

(A3, 80 g/m2) (20 Ib.)

Up to 7 kgs

308 x 432 mm
(12.12x17in.)

50 x 85 mm
(2x3.3in.)(multi-page)

50 x 65 mm

(2.5 x 2.5in.) (single-page)

27 ~ 413 g/m2 (7~110 Ib.)
27 ~ 105 g/m2 (7~28 1b.)
< 1.25 mm (0.05in.)
Compliant with

the ISO7810 ID-1 type
Hi-speed USB 3.0, RJ-45
Ethernet 10/100/1000 Mb
Base TX

AC 100-240V, 2A, 50-60Hz
100 C ~ 350

460 x 444 x 328 mm
(18.1x17.4x12.9in.)

25 kgs (55 Ibs.)
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